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1. INTRODUCTION  
RadSoft currently supports HOBI Labs' HydroRad instrument, and provides a 

framework for future support of other instruments from HOBI Labs as well as from 
other vendors.  Its essential functions are:  

� Collecting live data received through an RS232 port,  

� Applying instrument-specific calibrations to incoming data,  

� Storing raw and calibrated data in files,  

� Plotting live and stored data as a function of time, depth, or other variables 

� Controlling sampling rate and other instrument parameters  

� Retrieving logged data from instruments with internal memories, and 

� Providing an ASCII terminal interface for direct communication with 
instruments. 

1.1. SYSTEM REQUIREMENTS  
RadSoft requires Windows 95, 98, 2000, XP, NT 4.0, or subsequent 32-bit 

Windows operating system. A 400 MHz Pentium II or faster processor with at least 
64MB of RAM is recommended. RadSoft and the files required to support it occupy a 
minimum of about 10M of hard disk space.  

1.2.  INSTRUMENT FIRMWARE REQUIREMENTS  
Some RadSoft functions require that instruments have a certain level of 

firmware (internal operating software) installed. It is always possible to connect an 
instrument and communicate to it through the terminal window, in the same 
manner as with a simple terminal program, however some functions may not be 
available with some instrument firmware versions.  

1.2.1. HOBI Labs Instruments 

You can determine the firmware version of a HOBI Labs instrument by 
connecting it through a terminal program, or through RadSoft's terminal window, 
and sending the "VER" command.  

1.2.2. HydroRads 

Firmware versions earlier than 1.31 are not supported by RadSoft, and version 
1.33 is currently recommended.  RadSoft supports user upgrades of firmware (see 
section 3.3). 
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2. INSTALLATION  
Windows 2000/XP NOTE: You must be logged on as a user with administrator 

privileges in order for RadSoft to install all the necessary files on a Windows 2000 or 
Windows XP system. If not, the installation program will present an error message, 
and you must log on using a different account with the necessary privileges.  

2.1. CD-ROM  
1. Insert the CD-ROM in your computer.  

2. Run "RadSoftX.XXSetup.exe" (where X.XX is the version number) from the 
CD-ROM  

3. Click the Next button in the installer's Welcome dialog box.  

4. Decide whether you would like the RadSoft application stored in the default 
directory shown. If not, select a different directory. 

5. Click the Next Button. 

6. Decide if the default Start Menu folder is appropriate.  If not, select a different 
Start Menu folder. 

7. Click Next to see the selected settings. 

8. Click Back to change the installation settings, or Install to start the 
installation.  

9. When the installation is complete, click Finish to exit.  

2.2. INTERNET  
1. Download "RadSoftX.XXSetup.exe" (where X.XX is the version number) to 

your computer via the HOBI Labs web site at www.hobilabs.com. 

2.  Run "RadSoftX.XXSetup.exe" and follow the CD-ROM instructions, above. 

2.3. INSTALLATION NOTES 
You need not reboot your computer after installation, unless the installer 

program instructs you to do so.  

A "RadSoft" folder will be added to your start menu, and the directory you 
selected during installation will contain  

1. "RadSoft.exe" -- the RadSoft program,  

2. A folder called "Devices" containing a sub folder for each kind of device that 
the currently installed version of RadSoft can support.  That folder will 
contain various files specific to that device, such as firmware upgrades, 
graphical representations of the device, and keyword lists. 
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3. A folder called "Icons" containing several default bitmaps used to represent 
devices on the RadDesktop. 

4. The "Unins000.exe" program and "Unins000.dat" supporting data for 
uninstalling RadSoft.  

Also, a folder called "RadSoft" will be created within the "My Documents" folder.  
On most Windows machines, there is a shortcut to "My Documents" on the 
Desktop.  Alternately, you can instantly navigate to the folder by pressing the 
User files link in the About RadSoft dialog box, accessible from any Help menu.  
The "RadSoft" folder will contain: 

1. A folder called "Config", which will contain files with ".rad" extensions.  
These files maintain most of the RadSoft settings.  

2. A folder for each instrument supported by RadSoft, which will contain a 
folder called "Calibration".  This folder will contain calibrations 
downloaded from instruments, and is the default location for instrument-
specific calibration files (although they may be anywhere on the PC). 

3. A folder called "Temp" which contains temporary files created by RadSoft 
during live data collection.  During live data collection, there will be one raw 
data file, with a " .raw" extension in the directory, and one or more data files 
with ".dat" extensions.  Once the data is saved or discarded, the temporary 
data is cleared from this directory. 

4. A folder called "FileExt", which is used by the Device Explorer to determine 
how to graphically represent files.  While RadSoft does not delete these files, 
deleting these files will have no adverse effects on the system. 

5. A folder called "Download" which is created when files are downloaded from 
an instrument using the Device Explorer.  Normally, files in this directory 
are deleted when the program exits, or when the files have been processed.  
However, if there is a problem and the program crashes prematurely, the files 
will be left in this folder, in case they need to be recovered. 

2.4. REMOVING RADSOFT  
1. From the Start menu, select Settings, then Control Panel.  

2. Double-click on the Add/Remove Programs icon.  

3. Select RadSoft from the list of programs.  

4. Click the Add/remove button.  

OR  

1. Open the directory into which you installed RadSoft.  

2. Double-click on the "unins000.exe" program, which runs the un-installer.  
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3. QUICK START FOR HYDRORADS 

3.1. INITIAL CONNECTION 
1. Select RadSoft from the Windows Start Menu (see section 2 for installation).  

2. Connect the HydroRad to a serial port on your computer, using its 
Power/Data Interface cable. 

3. Click  on the toolbar (or select Connect from the File Menu (details in 
section 5.1).  

4. If this is the first time you have connected the HydroRad to this computer, 
select the "Load Calibration from Instrument" option. 

5. Select the Serial port and Baud rate, if known (if not, RadSoft can find them 
automatically in step 4), and set Instrument Type to HydroRad. 

6. Click the Connect button, or the Find Port & Baud Rate button if you are 
unsure of the port and/or baud rate.  

7. After a short time RadSoft should identify the instrument, optionally load its 
calibration, and close the Connect dialog box.  Note that loading the 
calibration may take several minutes. 

8. If you did not check "Load Calibration from Instrument", and this is the first 
time RadSoft has been used with the HydroRad, you will be prompted to 
select a calibration file on the PC.  If you click Cancel, and do not select a 
calibration file, you can still operate the instrument and collect data.  
However, RadSoft will be unable to calibrate the collected data. 

9. An icon representing the HydroRad will appear on the RadSoft Desktop.  
Also, the title of the menu between the Edit and View menus will change to 
the serial number of the HydroRad, for example “HR020325”.  We refer to 
this as the Device-Specific Menu. 

3.2. CHECKING FIRMWARE VERSION 
10.  Double-click on the device icon on the RadSoft Desktop to open its 

Terminal window. 

11. At the HydroRad> prompt, type 

VER 

followed by the enter key.  The reply will indicate the firmware version 
installed on your HydroRad.  RadSoft requires at least version 1.31, and later 
RadSoft versions may have different requirements.  Check the release notes 
for your version of RadSoft to see if a later version is required.  If not, proceed 
to step 16. 
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3.3. UPGRADING FIRMWARE 
WARNING 1: Interrupting an upgrade in progress can disable the HydroRad.  
Before starting, connect the HydroRad to its battery charger or an external 
supply to ensure that it will not lose power. 
 
WARNING 2: Upgrading to HydroRad version 1.31 from previous versions 
changes the operation of the LogAuto command and the Trigger switch.  
Briefly, the default mode for the LogAuto command has changed from 
"Seconds" to "Samples", and switching the trigger switch to the OFF position 
cancels any ongoing commands.  See the HydroRad v1.31 manual for details. 
 
WARNING 3: Upgrading to HydroRad firmware versions 1.31 and above from 
previous versions reduces the default AutoParams saturation range, for 
compatibility with the new Log and Acquire commands.  If you are going to 
continue using LogAuto command, you may wish to increase the AutoParams 
limits.  See the HydroRad v1.31 manual for details of the AutoParams settings.  

 

12. From the device-specific menu, select TroubleshootingÆUpgrade 
Firmware. 

13. You will be prompted to select a firmware file.  Normally this will be located 
in the directory Program Files/RadSoft/Devices/HydroRad/ and be named 
“HRADxxx.AHX” where xxx is the version number.  Select the file with the 
highest version number. 

14. Several steps will now automatically occur.  During the following steps, it is 
advisable to leave the computer alone, as initiating actions on the computer 
may put it into a busy state that causes it to perform incorrectly: 

a. RadSoft may force the instrument to a boot-loader baud rate. 

b. RadSoft will put the firmware into a special boot-loader mode. 

c. RadSoft will load software onto the instrument to allow firmware 
upgrades. 

d. RadSoft will upload the firmware. 

e. RadSoft will load software onto the instrument that locks in the 
firmware upgrade. 

f. RadSoft will re-boot the instrument. 

15. If any of these steps take more than a few seconds, RadSoft will provide a 
progress window for the step. 
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3.4. COLLECTING AND DISPLAYING DATA 

16. Press  on the toolbar, or select Acquire One Sample from the File Menu. 

17. Once data is available (which may take some time depending on the 
instrument and measurement conditions), a graph window will appear, as 
well as a live graph icon on the RadDesktop.  The new graph will zoom as 
needed to show all data.  

18. Double-click on background of the graph (or select Setup Graph… from the 
graph's Edit menu) to open the Graph Properties dialog box (details in 
section 7.2).  Adjust the graph parameters according to your preferences.  

19. From the graph, select File: Save Data File to save the calibrated data to 
your PC.  Additional data collected will be saved to the selected files (except 
for transposed data), until File: New Live Data File is selected. 
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4. RADSOFT DESKTOP WINDOW 
The RadSoft Desktop window is the core of the RadSoft program.  From this 

window, instrument operations can be launched, graphs can be manipulated, and 
data can be browsed.   Connected devices and data plots are represented in this 
window by graphical icons.  Double-clicking on these icons brings up either an 
interactive terminal window (for device icons), or a data plot (for graph icons).  
Right-clicking on an icon brings up a device-, or graph-specific menu of commands 
that can be used to manipulate and set up the device or graph. 

 

4.1. RadSoft Desktop Icons 
Instruments are represented on the RadSoft Desktop as icons. There are three 

possible states from these icons: Disconnected, Connected, and Communicating, as 
shown below: 

Disconnected Device 
Icon 

Connected Device Icon Communicating Device 
Icon 

   

Double-clicking on a device icon will launch its Terminal window (See section 
9).  Right-clicking will display the device icon's pop-up menu (see section 4.2). 

Live graphs are represented on the RadSoft Desktop by graph icons.  Graph 
icons are always associated with an instrument, and can issue commands to that 
instrument.  Graphs that only contain previously saved data do not appear as icons 
on the RadSoft Desktop, and do not have an inherent link to an instrument.  A graph 
may be associated with more than one device. 

Double-clicking on a graph icon will display the actual graph (if it is not 
already displayed), and bring that graph to the foreground.  Right-clicking will 
display the graph icon's pop-up menu (see section 4.2, below). 
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4.2. RadSoft Desktop Menus 
Depending on whether a single device, multiple devices, a graph, or a 

collection of devices and graphs are selected, the enabled contents of the File menu 
will vary.  In addition, there is a popup menu that appears when you right-click in 
the RadSoft desktop.  In addition to containing shortcuts to File menu items, the 
popup menu can also contain the Device-Specific Menu.  

 
If there is only one device on the RadDesktop, the menu items will apply to that 
device, even if it is not selected.  If there are no items on the RadSoft Desktop, 
selecting any of the menu items will create a new device, and apply the selected 
operation to that device. 

If a graph is selected, actions will apply to the device(s) attached to that graph via 
live data. 
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5. CONTROLLING AN INSTRUMENT  

5.1. CONNECTING  
To communicate with an instrument you must connect it to a serial (RS-232) 

communication port on your computer, and RadSoft must open the port at the 
correct baud rate. Many operations also require that RadSoft know what type of 
instrument is connected. Therefore RadSoft queries each instrument to identify itself 
at the time of connection.  

5.1.1. Connection Dialog Box  

 
This dialog box appears each time you  

� Press , or Select Connect from the File menu on the RadSoft Desktop, 
Terminal window or Graph Window. 

� Attempt an operation that requires a connection, if a connection has not 
yet been established (i.e., acquisition, logging, launching Device 
Explorer).  

In the Connect to Instrument dialog, pressing the Connect button creates a 
device icon (see RadSoft Desktop Icons in section 0) that can be manipulated via its 
pop-up menu, or via the terminal window that appears when you double-click on 
the icon (see terminal windows in section 9). 

Pressing the Find port & baud rate button steps through every available serial 
communications port at every available baud rate to identify the instrument.  Once 
the instrument is identified, it is connected, as described above.  Pressing Close 
during this operation will stop the search immediately. 

Manual Connection  

If you click the Connect button, RadSoft will open the currently selected port 
at the selected baud rate. If it receives a reply sufficient to identify the instrument, it 
will proceed with the connection and close the dialog box. If not, it will notify you 
and ask whether to open the connection anyway. In you instruct it to, it will proceed 
on the assumption that an instrument of the type you designate is connected.  
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Connection with Find Port & Baud Rate 

If you click Find port & baud rate, RadSoft will ignore the selected port and 
baud rate, and attempt a connection to each port, at each baud rate (from 300 to 
230400), until it receives valid identifying information from an instrument. The 
dialog box will automatically close if a valid connection is found.  

Load Calibration From Instrument Option  

If Load Calibration From Instrument is checked at the time an instrument is 
connected, RadSoft will prompt the instrument to transmit the calibration 
information stored in the instrument's memory. This will override the currently 
selected calibration file, if any. See section 13 for more information about calibration 
files.  Please note that on some instrument, such as HydroRads, downloading the 
calibration can be a very time-consuming task, particularly if the baud rate is set to a 
low value. 

Delaying connection 

There is a checkbox labeled Save port & baud settings and open port later 
via Reconnect.  This can be used if you want to set up the RadSoft desktop for 
multi-instrument use, but don't have the instruments on-hand yet.  Selecting this 
disables the Search button and changes the Connect button to Connect Later. 

5.1.2. Connecting to a Sleeping Instrument  

In rare cases RadSoft may not detect the presence of an instrument that is in its 
low-power "sleep" mode. If you have difficulty connecting to a sleeping instrument, 
we recommend you use the instrument's magnetic switch to wake it before 
connecting.  

5.2. COLLECTING REAL-TIME DATA  
To start collecting data from an instrument, click or select either Acquire One 

Sample ( ) or Acquire Continuous Samples ( ) from the File menu. If no graph 
is visible when you start collection, RadSoft will open one.  

Note that it is the instrument, not RadSoft that determines the pace of data 
collection once it has been started. Therefore there may be a delay before data 
actually appears. If you want to see the progress that the instrument is making, you 
can double-click on the instrument icon to show the instrument's Terminal window. 

Also, some instruments are capable of logging data to their flash memory.  To 
initiate logging to flash memory, select Log One Sample or Log Continuous 
Samples from the File menu (no toolbar shortcut). 

If Acquire Continuous Samples ( ) or Log Continuous Samples was used 
to initiate sampling, Stop Collection ( ) should be used to cease data collection. 
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On some instruments, Stop Collection can also be used to cease single data 
collections, if the single data collections are time consuming. 

5.3. SETTING SAMPLING OPTIONS 

The Set Up Selected Items on the File menu (  on the toolbar) will only be 
enabled if the selected device(s) are attached.  Set Up Selected Items will bring up 
the default device-specific setup dialog, as described in the following sections.   

The options shown, and number of tabs will vary by instrument.  Usually, 
there will be options for setting sampling intervals and sample duration and/or 
sample count.  Often, the settings displayed will be a combination of built-in 
instrument settings that are saved on the instrument, and RadSoft-specific settings 
that are stored on the PC.  These settings will influence how Acquire One Sample 
and Acquire Continuous Samples operate. The settings that influence Log One 
Sample and Log Continuous Samples may be in a separate set of dialogs, available 
through the instrument-specific dialog. 

5.3.1. HydroRad Acquisition Setup 

The settings in this dialog box control how data will be collected from the 
HydroRad under the direct control of RadSoft, as opposed to when it is logging 
internally.  Internal logging parameters are controlled with the Logging Setup dialog 
box (see section 5.3.2) 

HydroRad Acquisition - Data Collection Parameters 
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The Data Collection parameters tab is used to specify which channels to 
collect data from, when to collect the data (in continuous sampling mode), and how 
to save a copy data to the HydroRad Flash (if so desired).  

The channels checked in the box labeled "HydroRad Channels to Sample" will 
be enabled during acquisition.  Un-checking unused channels will speed up data 
acquisition. 

Normally, data will not be saved to the HydroRad flash during PC-based 
data acquisition.  Saving to flash can take a few seconds longer, and can cause 
problems if the flash memory becomes full. Nevertheless, checking "Save copy to 
HydroRad Flash" will cause a copy of the collected data to be saved to the 
HydroRad.  If "Save copy to HydroRad Flash" is selected, then you can select an 
optional root name for the flash files, and can select whether to save the data in one 
file per channel, or one combined file containing the data from all channels.   

The Continuous Sampling Options control how data is collected during 
continuous sampling.  Normally, data is collected quickly and continuously.  
However, it is possible to specify a sampling period.  If a sampling period is 
specified, then the HydroRad take the number of samples specified under "# of 
Samples in each period", then will sleep for the remainder of the period, wake up at 
the end of the period, and take the specified number of samples.  If the number of 
samples is greater than one, then the option to average the samples appears. If 
"Average the samples" is checked, then the HydroRad firmware will average the 
samples together before sending them to RadSoft and/or storing them.   

Please note: if "Average the samples" is checked and the integration time is 
not set to manual (see below), then the HydroRad processing level (see below) 
should be set to "3" - Linearity and Time Adjusted. 

The final item in the dialog, "Save logging settings to HydroRad flash memory" 
applies only to the settings that are shared between acquisition mode and logging 
mode.  These shared settings are listed under the Exposure tab and the Power 
Saving tab, both of which will be explained shortly. 
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HydroRad Acquisition - RadSoft Processing 

   
The RadSoft Processing tab is used to select the processing operations that 

will be applied to all HydroRad data.  This tab is identical to one that shows up 
when RadSoft Preferences is selected from the Edit menu of the RadSoft Desktop, 
and the "HydroRad" tab is selected. 

Please note: The settings selected in this tab apply to all HydroRad data, 
including data from other HydroRads that may be connected, as well as data loaded 
from files stored on the PC.   

"Calibration Level" is normally set to "4" - Full Engineering Calibration, which 
applies a full calibration to the collected data.  Lower levels of calibration (0 to 3) are 
normally used for debugging only.  Setting the calibration level to "5" - Remove 
Immersion may be used rarely and carefully, if the calibration for an instrument's 
sensor contains an immersion coefficient, but the sensor was used in air.  Calibration 
level "5" will then divide out the immersion calibration from the data.  If an equal or 
higher level of processing is specified for HydroRad processing (next section), then 
the HydroRad processing is left as-is. 

Please note: If Calibration level "5" is used on data collected with an 
immersed sensor, then the resulting data will be incorrect. 

Selecting "Set Over Exposed Data to Zero" only has an effect if data was 
collected form the HydroRad with level 0 or level 1 processing.  This will set over-
exposed values to zero so they can be ignored in the data set. 

The setting under "Acquisition Limit" affects live data collection only.  If 
"Max# Live Samples" is left at zero, then it has no effect, and all live data will be 
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stored in memory until memory fills.  However, if a positive number is specified 
here, then only that many samples will be stored in memory, and memory will not 
be likely to fill up.  When the limit is hit, samples will begin dropping off the live 
data graph (but will still be stored live to disk).  If this occurs, then the Crop and 
Delete commands in the Graph window become disabled (see sections 8.2 and 8.4).  
Also, if Crop or Delete was previously used on a data set, and the data set's 
acquisition limit is subsequently reached, then the changes made by those 
commands will be discarded. 

"RadSoft data subsampling" can be used to evenly space out data collected 
from HydroRads, which usually have a different 2nd order wavelength calibration 
for each channel, and an be difficult to manipulate vs. wavelength.  If "Sub sample 
data collected form HydroRad" is checked, then an evenly spaced data set is created 
for each channel, from the "First Wavelength" to the "Last Wavelength", with 
"Wavelength increment" spacing.  If the selected wavelengths do not fall directly 
over a pixel, the nearest pixel to that wavelength will be used.  If "First Wavelength" 
falls below the lowest wavelength data point, then the data from the lowest 
wavelength data point will fill in the missing values.  Likewise, if the "Last 
Wavelength" falls above the highest wavelength data point, then the data from the 
highest wavelength data point will fill in the missing values.  Subsampling does not 
cause any filtering of data to occur.  That must be specified separately. 

"RadSoft data filtering" can be used to smooth out noise in data, and should 
be used when subsampling is also used, especially when the wavelength increment 
is large.  Either a boxcar (simple averaging) filter, or a Gaussian (Normal distribution 
curve) filter can be used. If a boxcar filter type is selected, then each output data 
point will be averaged with its neighbors in a band as wide as the specified 
bandwidth.   If a Gaussian filter type is selected, then each output data point will be 
averaged with its neighbors in a band about twice as wide as the specified 
bandwidth, but with a weighting that follows the Normal distribution curve, such 
that the full width at half max (FWHM) of the Normal distribution matches the 
specified bandwidth.   If the width of a filter exceeds the input data, then the end-
point values of the input data will fill in missing values. 

If the data was previously filtered, then the filter bandwidth actually applied 
will be the difference between the old filter width and the new filter width. 
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HydroRad Acquisition - HydroRad Processing 

 
The settings under the "HydroRad Processing" tab affects the processing that 

the HydroRad firmware applies to data as it is collected.  Normally, "No on-board 
HydroRad processing" should be selected, which will ensure that the full range of 
raw data is available to RadSoft, should re-calibration ever become necessary. 

However, in rare instances, such as when the instrument is connected over a 
very low bandwidth connection, and collection speed is of high importance, then 
limited processing may be warranted. 

Normally, "HydroRad Calibration" is set to "0" - Raw Values Out.  However, if 
other filtering or sub-sampling selections are made on this page, then "1" - Bad Pixel 
Adjustments should be selected to ensure that bad pixels are not included in the 
averaging and sub-sampling. 

Under "Range of data generated by the HydroRad", either an evenly spaced 
wavelength range, or an evenly spaced pixel range can be selected.  When the 
selected range is wider than one pixel, then filtering is recommended.  Also, if any 
range other than a pixel range with a spacing of 1 pixel is selected, then "HydroRad 
Calibration" should be set to "1" - Bad Pixel Adjustments.  If in the Data Collection 
Parameters tab, "Average the samples" is checked and the integration time is not set 
to manual (see below), then the HydroRad processing level should be set to "3" - 
Linearity and Time Adjusted. 

The settings under "Filter Specifications" can be used to smooth out noise in 
data, and should be used when subsampling is also used, especially when the 
wavelength/pixel increment is large.  Either a boxcar (simple averaging) filter, or a 
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Gaussian (Normal distribution curve) filter can be used. If a boxcar filter type is 
selected, then each output data point will be averaged with its neighbors in a band 
as wide as the specified bandwidth.   If a Gaussian filter type is selected, then each 
output data point will be averaged with its neighbors in a band about twice as wide 
as the specified bandwidth, but with a weighting that follows the Normal 
distribution curve, such that the full width at half max (FWHM) of the Normal 
distribution matches the specified bandwidth.   If the width of a filter exceeds the 
input data, then the end-point values of the input data will fill in missing values. 

If anything other than "No Filtering" is selected, then "HydroRad Calibration" 
should be set to "1" - Bad Pixel Adjustments. 

HydroRad Acquisition - Exposure time settings 

  
"Speed Auto" Exposure uses an iterative exposure time determination routine 

for the first sample (or any sample collected after a 30 second pause).  The iterative 
exposure time determination routine collects a sample, and evaluates whether it is 
over or under exposed.  If it is either, the sample is thrown away, and a new sample 
is collected a different integration time.  This repeats until a well-exposed sample has 
been obtained.  This well exposed sample is then stored.  Subsequent samples 
however are all stored.  If the sample is overexposed or near overexposure, 
subsequent samples will have shorter exposure times, and if the sample is 
underexposed or near underexposure, subsequent samples will have longer 
exposure times.  If the light field changes rapidly and significantly, then there could 
be several under- and over-exposed samples. 
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"Auto All" Exposure uses the iterative exposure time method for every data 
sample, so that no samples will ever be under- or over- exposed.  However, it may 
require several measurements to get each data sample, so the overall sampling rate 
will be lower than with Speed Auto Exposure.  However, if the light field is expected 
to change rapidly and significantly, Auto Exposure may be necessary to avoid the 
under- or over- exposed samples that may occur with Smart Exposure. 

If either Speed Auto Exposure or Auto All Exposure is selected, then the "Auto 
Exposure Settings" panel will appear (as shown above).  Since the Auto Exposure 
settings are rarely modified, the same settings apply to both Acquisition setup and 
Logging Setup.  Changes made under Acquisition setup will affect Logging Setup, 
and vice versa.  The following settings can be specified: 

� Minimum time (msec): This is the minimum integration time that the iterative 
exposure routine will try to use.  For most HydroRads, this cannot be set 
below 21 or 22 msec. 

� Maximum time (msec): This is the maximum integration time that the 
iterative exposure routine will try to use.  Practically speaking, values higher 
then 40000 are not recommended, as noise starts to predominate. 

� Minimum Threshold (Counts): "Counts" refer to the raw data value measured 
by the spectrometer, which typically varies from about 1000 to 32760.  If the 
peak of the measured spectrum does not exceed the minimum threshold, then 
the spectrum is considered under-exposed.  Note: in versions of the 
firmware previous to 1.31, this was set to 25000, which may be more 
appropriate for use with the LogAuto command.  

� Minimum #Pixels Over Minimum: Typically, this is set to one.  However, for 
debugging purposes, it may be desirable to set a higher value.  

� Saturation Threshold (Counts): If the peak of the measured spectrum exceeds 
the saturation threshold, then the spectra is considered over-exposed. Note: 
in versions of the firmware previous to 1.31, this was set to 30000, which 
may be more appropriate for use with the LogAuto command. 

� Maximum #Pixels Over Saturation: Typically, this is set to zero.  However, 
for debugging purposes, it may be desirable to set a higher value. 

� Maximum #Attempts: This sets how many times the iterative integration 
routine will attempt to find the ideal integration time for a sample.  For Smart 
Exposure, this affects the first sample.  For Auto Exposure, this affects every 
sample. 

� #Pixels to PreFilter: To limit the effect of bad pixels, a median filter of the 
specified width is applied to the data before the under- and over- exposure 
calculations are performed.  The width must be an odd number of pixels.  A 
width of 1 shuts off pre-filtering, while the default value of 3 has been 
optimized for speed. 
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Please note that higher Minimum Threshold and Saturation Threshold settings 
will result in more fully saturated, potentially more accurate readings when used 
with the "Auto All” exposure mode.  However, when using the default "Speed Auto" 
mode, higher settings will lead to more over-exposed samples, and less usable data.  
In fact, if light levels are changing rapidly, lower Minimum Threshold and 
Saturation Threshold settings will result in fewer over-exposed measurements, and 
more usable data in the default "Speed Auto" mode.  Recommended settings for 
Minimum Threshold and Saturation Threshold are:  

� For general use: 20000 and 25000.   

� For highly accurate readings in "Auto All" mode: 25000 and 32700.   

� For fewer over-exposed readings when light levels are variable and 
"Speed Auto" is being used: 13500 and 18500. 

If in the Data Collection Parameters tab (see above), "Average the samples" is 
checked and the integration time is not set to manual, then the HydroRad processing 
level (see above) should be set to "3" - Linearity and Time Adjusted. 

The final item in the dialog, "Save logging settings to HydroRad flash memory" 
applies to these settings, which are shared between acquisition mode and logging 
modes.  If the checkbox is checked, then the settings are saved to the HydroRad flash 
memory, and will be retained if the HydroRad is reset or cycles power. 

If the "Fixed" is checked, then the "Auto Exposure Settings" panel will be 
replaced by the "Fixed Exposure Time Settings" panel (see below). 

  
The " Fixed Exposure Time Settings" panel contains an entry for each channel 

of the instrument.  The number that appears for each channel will be the last 
integration time for that channel.  If you want to specify a different integration time 
for a channel, type it into the box beside the channel.  The times specified here are 
maintained in the HydroRad volatile RAM memory.  So, if the HydroRad is reset, or 
a command is executed on the HydroRad that changes its integration times, then the 
specified values will be lost. 
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HydroRad Acquisition - Regulating Power usage 

  
Since the power usage settings are rarely modified, the same settings apply to 

both Acquisition setup and Logging Setup.  Changes made under Acquisition setup 
will affect Logging Setup, and vice versa. 

If "Shut down spectrometers if they are idle" is checked, then power to the 
spectrometers will be turned off if they are idle for more than 2 seconds plus the 
specified warm up time. 

The "Spectrometer warm-up time" is the number of seconds the spectrometer 
will wait after power is turned on before collecting a spectrum.   

If "RadSoft enables spectrometer power immediately when HydroRad is 
connected" is checked, then RadSoft will send a "Power On" command to the 
HydroRad after establishing communications.  This will speed up the first 
subsequent data collection, as it will not have to wait for the spectrometer to warm 
up (assuming that "Power Spectrometers Continuously" is also checked). 

Checking "RadSoft puts HydroRad to sleep before closing connection" will 
cause RadSoft to send a "Sleep" command to the HydroRad just before the RadSoft 
connection to the instrument is shut down, either manually, or when RadSoft is quit. 

The final item in the dialog, "Save logging settings to HydroRad flash memory" 
applies to these settings, which are shared between acquisition mode and logging 
modes.  If the checkbox is checked, then the settings are saved to the HydroRad flash 
memory, and will be retained if the HydroRad is reset or cycles power. 

5.3.2. HydroRad Logging Setup 

The settings in this dialog box control how data will be collected internally on 
the HydroRad when it is not under the direct control of RadSoft.  Real-time 
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acquisition parameters are controlled by the Acquisition Setup dialog box (see 
section 5.3.1). 

HydroRad Logging - Data Collection Parameters 

  
The Data Collection parameters tab under Logging Parameters is very similar 

to the same tab under Acquisition Parameters.  It is used to specify which channels 
to collect data from, when to collect the data (in continuous sampling mode), how to 
save a copy data to the HydroRad Flash, and whether to send data to RadSoft  (if so 
desired).  

The channels checked in the box labeled "HydroRad Channels to Sample" will 
be enabled during logging.  Un-checking unused channels will speed up data 
logging. 

Data will always be saved to the HydroRad flash during logging. However, 
data can also be simultaneously sent to RadSoft, by checking "Send copy to Serial 
Port (RadSoft)".   Sending data to RadSoft during logging can take a second or two 
longer, but may be desirable as a back up or for monitoring.   

For the data that is saved to flash, you can select an optional root name for the 
flash files, and can select whether to save the data in one file per channel, or one 
combined file containing the data from all channels.   

The Continuous Sampling Options control how data is collected during 
continuous sampling.  Normally, data is collected quickly and continuously.  
However, it is possible to specify a sampling period.  If a sampling period is 
specified, then the HydroRad take the number of samples specified under "# of 
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Samples in each period", then will sleep for the remainder of the period, wake up at 
the end of the period, and take the specified number of samples.  If the number of 
samples is greater than one, then the option to average the samples appears. If 
"Average the samples" is checked, then the HydroRad firmware will average the 
samples together before sending them to RadSoft and/or storing them.   

Please note: if "Average the samples" is checked and the integration time is 
not set to manual (see HydroRad Acquisition - Exposure time settings above), then 
the HydroRad processing level (see HydroRad Acquisition - HydroRad Processing, 
above) should be set to "3" - Linearity and Time Adjusted. 

HydroRad Logging - HydroRad Processing 

The HydroRad Processing tab for Logging Setup is identical to the tab for 
Acquisition Setup (see previous section), with the exception that its selected settings 
are stored on the HydroRad, rather than on the PC. 

HydroRad Logging - Exposure time settings 

The Exposure tab for Logging Setup is identical to the tab for Acquisition Setup 
(see previous section), with the exception that the choice of Smart, Auto, or Manual 
integration is stored independently of the settings for Acquisition.  The "Auto 
Exposure Settings" and "Manual Exposure Settings" are shared between Logging and 
Acquisition modes. 

HydroRad Logging - Regulating Power usage 

The Exposure tab for Logging Setup is identical to the tab for Acquisition Setup 
(see previous section), and shares the same settings. 

5.4. RETRIEVING LOGGED DATA 

Selecting RadSoft Explorer ( ) from the File me will launch the Device 
Explorer for the selected instruments.  The Device Explorer enables you to view the 
data stored in an instrument's memory, transfer the data from the instrument to files 
on your computer, and erase the data from the instrument's memory. The data you 
transfer is stored in individual files whose location you specify. (For some 
instruments, you also supply a base name, and the cast number is appended to form 
the name of each file).  

5.4.1. Retrieving Data  

From the RadSoft Desktop, if there is more than one device, click on that device 
to select it, and Select Device Explorer ( ) from the File.  If there is only one 
device, then it will be automatically selected.   

After a pause (during which lines will scroll in the Terminal window), a 
window like the following will appear: 
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After the directory is loaded, select the data sets or casts you wish to retrieve. 

Right click on the selected files to bring up a menu, which will allow you to either 
get the files from the instrument and save them to disk, or to open them directly in 
RadSoft (depending on the capabilities of the attached instrument, additional 
options may appear). 

If you choose to get the files from the instrument, then you will be prompted 
for a directory into which to save the files.  (If the instrument saves files with serial 
names such as "Cast1", "Cast2", etc, then you will also be prompted for a base file 
name for the downloaded files. The cast number will be appended to this base name 
to create a unique name for each cast you download.)  

You may also simply drag the selected files from the RadSoft Explorer into a 
Microsoft Windows© folder, or onto the Windows© Desktop. 

Depending on the quantity of data and baud rate, downloading may take some 
time. Status messages and a graphical indicator will show the download progress.  

5.4.2. Selecting Files 

Depending on the type of instrument and the number of data sets stored, 
loading the directory may take a number of seconds. The Device Explorer window 
goes blank when it is in the process of loading.  

You can select arbitrary groups of data sets for downloading. To select a 
contiguous group of casts, click on the first item in the group, then shift-click on the 
last item; or hold down the shift key while using the arrow keys. To select or 
unselect non-contiguous casts, control-click on them; or hold down the control key 
while using the arrow keys to move through the directory, and press the space bar to 
select or unselect casts.  
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5.5. SETTING INSTRUMENT DATE AND TIME  
To set the real-time clock in a connected instrument, select Set Date/Time 

from the Instrument-specific menu. The Set [Serial#] Date & Time dialog will 
appear.   

 
 To set the instrument to the current PC time, simply press the Set [Serial#] 
to PC Date & Time button. The instrument's time and date will update in the 
bottom middle label when this occurs.  To set the instrument to a different time and 
date, type the time and date into the box in the middle of the dialog, and press the 
Set [Serial#] to Other Date & Time button. 

5.6. CHANGING BAUD RATE  
The Set Baud Rate… command on the Instrument-Specific menu opens a 

dialog box in which you can select a new baud rate for communication between the 
connected instrument and your computer. Select a new baud rate and from the drop-
down list, and click Execute.  

 
If "Wait for instrument confirmation" is checked, then RadSoft sends a 

command (at the current baud rate) to the instrument instructing it to change rates,.  
When the instrument confirms the change, RadSoft responds by changing its own 
baud rate to match the instrument.  

If "Force new baud rate" is checked, then RadSoft sends a command to the 
instrument instructing it to change rates, and subsequently changes its own baud 
rate to match the instrument without waiting for the instrument to confirm the 
change.   This may be useful if the instrument is already at a different baud rate, and 
you want to switch RadSoft to that rate. 

 It the instrument does not respond after a baud rate change, it may be that a 
communication error interfered with the transition. In this case, try re-connecting at 
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the previous rate by selecting Connect from the File menu (  on the toolbar).  In 
the Connect to Instrument dialog that appears, try selecting the previous port & 
baud and press the Connect button.  Alternatively, just pres the Find port & baud 
rate button, and the Connect to Instrument dialog will attempt every available 
combination of ports and baud rates.  

5.7. DEVICE-SPECIFIC COMMANDS 

5.7.1. File Menu and Popup Menu Commands 

The following commands are common, often used commands used on most 
instruments, so they appear in the File menu and popup menu, and some have 
icons on the toolbar: 

� Acquire One Sample (  on the toolbar):  This command instructs the 
device to collect one sample, using the settings configured in the Item 
Setup window, and display the data in a graph. 

� Acquire Continuous Samples (  on the toolbar): This command 
instructs the device to collect continuous or evenly spaced samples, 
using the settings configured in the Item Setup window, displaying the 
live data in a graph. 

� Log One Sample (no toolbar shortcut):  If the device can log to its own 
memory, this command instructs the device to collect and internally 
store one sample, using the settings configured in a dialog available 
through the device-specific menu. 

� Log Continuous Samples (no toolbar shortcut):  If the device can log to 
its own memory, this command instructs the device to collect 
continuous or evenly spaced samples, using the settings configured in a 
dialog available through the device-specific menu. 

� Stop Sampling ( ): This command stops continuous acquisition 
and/or logging. 

� Device Explorer ( ): The command launches the Device Explorer, 
for downloading logged data files. 

� Item Setup… ( ):  This command launches the acquisition setup 
window, for configuring data collection and logging parameters. 

5.7.2. Commands on the Device-specific Menu 

The following items may appear at the top of the device-specific menu: 

� Set up Acquisition…: Appears only if Set up Logging… also appears 
(see below).  Identical to Item Setup (see above).  See instrument-
specific descriptions in section 5.3 for details of the Item Setup dialog. 
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� Set up Logging…: This item will only appear if the device is capable of 
logging to its internal memory, and if it is capable of storing 
configuration settings. 

� Collect Once Custom: This allows for the collection of one sample of 
data (which may consist of several actual measurements), using the one-
time settings selected for this command (bypassing the instrument 
setup dialog). 

� Set Date/Time: as described above, in Section 5.5. 

� Set Baud Rate…: as described above, in Section 5.6. 

� Load Calibration from PC…: Opens a standard file open dialog to 
select a calibration file for the device.  If a new calibration file is 
selected, the new calibration will apply to all new data. 

� Load Calibration From Instrument…: If the instrument is capable of 
storing its own calibration, then this item will appear.  This will either 
immediately download the calibration from the instrument, or prompt 
you for the filename of the calibration to download. 

� Troubleshooting Æ Long Break Reset: For instruments that support 
long-break resets, sends a long "break" down the serial port to reset the 
instrument. 

� Troubleshooting Æ Upgrade Firmware: For instruments that support 
firmware upgrades through the serial port, this command performs the 
upgrade.  See section 3.3 for a detailed procedure. 

� Scripts Æ New Script: (appears only for scriptable instruments, such as 
the HydroRad).  This creates a new script in the script editor (see section 
11) 

� Scripts Æ Open Script (appears only for scriptable instruments, such 
as the HydroRad). This opens a script residing on the PC in the script 
editor (see section 11).  

� Scripts Æ Run Script (appears only for scriptable instruments, such as 
the HydroRad). This will prompt you for the name of a script on the 
instrument to run on the instrument (see section 11).  

� Scripts Æ Stop Script (appears only for scriptable instruments, such as 
the HydroRad).  This will stop a script running on an instrument (see 
section 11). 

5.7.3. Direct Commands 

After the less-common commands appearing in the device-specific menu, there 
will be a detailed list of every command that can be sent to the instrument.  RadSoft 
does not provide intelligent interpretation of most of these commands or of the 
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instrument’s responses.  However it provides a dialog box to assist the user in 
assembling the commands according to the instrument’s syntax. 

 The Command dialog appears for the commands selected from a Device-
Specific Menu.  Clicking on such an item launches a command dialog that displays 
the command name, and includes an edit box of each filed of the command.  Help 
information is also displayed to assist the user with filling in the command: 
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6. PROCESSING PC-STORED DATA 
Raw or binary data directly downloaded from an instrument and stored on a 

PC, either through RadSoft, or through any other communications programs can be 
calibrated, displayed, and saved in an ASCII format by RadSoft.   

6.1. Opening Data Files 
Selecting Open file… from the File menu of either the RadSoft Desktop or a 

Terminal window will launch the file chooser, shown below: 

 
The file chooser is like any standard Windows file chooser, with one exception 

-- there are two checkboxes on the bottom.  One allows you to wildcard match the 
last non-extension character of file names.  The other allows you to open all the 
selected files into the same graph.   

Selecting the option to Wildcard match the last non-extension character is 
useful for instruments such as HydroRads, which can save a single data set in 
multiple files with similar names, such as FileA.asc, FileB.asc, FileC.asc, etc.   

When multiple files are selected, normally each file will be opened into its own 
graph window.  However, if Overlay files into the same graph is selected, all the 
files will be opened in the same graph. 

Selecting Open PC Files in this Graph… from the File menu of a Graph 
window will launch the same dialog, except that opened files will appear in the 
currently opened graph.    
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6.2. Setting Time Format 
By default, RadSoft exports time values in the Microsoft data/time format (also 

referred to as Microsoft Excel format), which expresses the time and data as a 
fractional number of days since 12/30/1899 (the Excel documentation incorrectly 
states that the value 1 corresponds to 1/1/1900).    

Other formats can be selected in the RadSoft Preferences window, selectable 
through the RadSoft Desktop 's Edit menu.  The second tab in this window is the 
Time format table, which allows you to select how time values will be saved in 
output files (and in the data viewer), and also allows for the specification of default 
time formats for display in graphs that have time on one axis (or on the slider bar).  
Selected values are saved between sessions.  Output options include MATLAB 
format, SPSS format, Microsoft (Excel) format, Igor format, SAS format, C-Language 
format, or as a date & time string.   

Raw time values are saved in their native format. 

 

6.3. Setting Processing Parameters 
Some instruments will have processing parameters that can be set through the 

Preferences dialog, selectable through the RadSoft Desktop Edit menu.  Such 
menus will be tabbed next to the "General" and "Time Format" tab on the RadSoft 
Preferences window, as shown in the example below. 
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 The settings selected here will apply to downloaded files, and files loaded 
from the PC.  Data logged directly from an attached instrument may be processed 
differently, if the instrument is capable of internal processing (see the instrument 
specific setup instructions in section 5.3). 
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7. PLOTTING DATA  
Data plots in RadSoft may show data read from an existing file, or received in 

real time from a connected instrument.  

7.1. Default Data Plots  
A new graph window with the data plotted in the default data plot style 

appears whenever a data file is opened.  For multi-channel instruments, a single 
graph appears for all the channels of the instrument.  You can select whether the 
data are displayed as a function of wavelength, depth, or of time, through the Graph 
Setup dialog menu (see section 7.2).  

 

7.1.1. Pointer Coordinates 

Whenever the mouse pointer is within the plot area of a data window over a 
plotted data set, a small window that shows the data coordinates of the data point 
under the pointer appears.  

This allows you to determine the exact value of a particular data point simply 
by pointing at it. 

7.1.2. Legend 

The Legend on the right side of the data window lists the parameters displayed 
in the current graph. Normally these correspond to the data channels in the file 
opened, or to the data channels of the connected instrument.   
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You can choose which channels are displayed in the graph by clicking the 
check boxes to the left of each channel name.  

Note however that choosing not to display a given channel is temporary, and 
the channel will re-appear after the graph is refreshed. To permanently remove a 
channel from the display, use the Graph Setup dialog (see section 7.2).  

7.2. GRAPH SETTINGS DIALOG BOX  
All graphical characteristics of a data plot are controlled through the Graph 

Properties dialog box. To open it from a graph, select Setup Graph from the Graph 
window's Edit menu, or double-click on the graph.  To open it from the RadSoft 
Desktop, select the graph icon, and select Setup Item… from the File menu.  When 
you open the dialog box it will contain the settings of the current graph.  

The Graph Settings window's "Configure graph" tab will be selected if the 
setup window was selected from a menu, or if the background of a plot was double-
clicked on. If an axis or data series was double-clicked on, either the "Setup Axes" tab 
or the "Setup Series" tab will be selected, as appropriate. 

7.2.1. Data to Plot Tab 

The "Data to Plot" tab allows you to specify which of the currently loaded data 
sets to display in the graph.  Once those data sets have been selected, it also allows 
you to select which variable to use as the dependent variable, and along which axis 
and direction to plot the dependent and independent variables.  (Only one 
independent variable may be selected for a plot, although several dependent 
variables may be selected). 

 

7.2.2. Axis Ranges & Labels Tab 

The "Axis Ranges and Labels" tab allows you to configure how axes are 
labeled, and to configure the numerical range of axes.  On the left side of the 
window, all the currently graphed variables appear, and on right side, all the 
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settings for the selected variable appear.  Every setting can be auto-set be clicking on 
the "Auto" box to the left of the setting.   

 
 Setting the "Caption" sets how the axis is labeled on the graph.  The "Auto" 

value for the caption is the same as the axis name, displayed on the left.   

The Minimum, Maximum, and Increment settings are quite obvious, unless the 
variable is "Time," as in the example above.  In that case, the settings refer to 
fractional days.  As you adjust the values, the actual time limits or increment appear 
to the right of the edit box.   

The Format setting affects how the values appear on the axis.  Depending on 
whether the axis is time or numeric, the available format codes will vary.  The 
scrollable box below the Format setting box will vary also, to help you generate the 
format string.  

7.2.3. Lines & Symbols Tab 

The "Lines & Symbols" tab contains settings for configuring the appearance of 
a data series. Lines between points, and/or symbols at each point can be selected for 
each data series.  

For series lines, the line color and with can be selected.  If you are using an 
older computer, selecting only lines can speed up graph drawing several hundred 
times over displaying points at each point. 

For drawing symbols at each data point, there are several more options.  The 
symbol shape and size can be selected, as well as the background color, and outline 
width and color. 
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7.3. Other Scaling, Panning and Zooming Options  
While you can enter exact numeric limits for each axis via the Graph Properties 

dialog box, RadSoft provides several more rapid options. The Zoom In ( ) and 
Zoom Out ( ) commands on the View menu contract or expand the axis limits by a 
factor of 2.  

The Auto Scale ( ) command on the View menu adjusts the scales to exactly 
fit the entire data set.  

At any time you can "drag-zoom," that is, click and drag the mouse pointer in 
the graph area to define a rectangle. When you release the mouse, the axis limits will 
be set to the boundaries of that rectangle. One of the quickest ways to navigate in a 
dataset is to first use Auto Scale ( ) to show all the data, then "drag-zoom" to 
expand the subset of interest.  

Holding down the Shift key while "drag-zooming" causes the display to zoom 
out, such that the currently displayed plot area zooms into the window just drawn. 

The axis arrows ( , ,  and ) can be held down to scroll the selected axis in 
the direction held down.  Double right-clicking on an axis disables the axis arrows, 
and also disables drag-zooming for that axis. Double right -clicking again restores 
the axis arrows and drag-zooming.  This is a handy technique if there are several 
dependent axes, and you do not wish to zoom one or more of the axes. 

Holding down the right mouse button and dragging across the plot area pans 
all axes in the direction dragged. 
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After changing the scaling using one of the zoom commands, or drag-zoom, 
you can use the Zoom Previous ( ) command on the View menu to undo the 
changes.  

7.4. PRINTING AND EXPORTING GRAPHS  
You can print the graph from a main data window by selecting Print Graph 

( ) from the File menu. Print Graph launches a previewer, from which you can 
specify margins, level of detail, and paper orientation. 

 

Save Graph as Image ( ), also on the File menu, allows you to save the 
currently displayed graph in a variety of image formats.  Several of the formats have 
additional options for controlling color sampling and compression.  

 



 35

You can also copy the image for pasting into other applications.  Copy as 
Bitmap ( ), on the Edit menu is the best method if the image is going to be pasted 
into an image editor or paint program for further editing.  Copy as Metafile ( ), 
also on the Edit menu, is more appropriate if the image is going to be copied into a 
document or presentation, or if a metafile image editor is going to be used.  
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8. HANDLING DATA 
In RadSoft, all data is maintained in graphs.  Once a data set has been removed 

from all graphs, it is deleted from memory.  The same data set may exist in several 
graphs at one time, displayed identically, or even plotted on different axes.  
Updating a data set, either by adding live data, or by re-loading saved data, updates 
it in all windows. 

8.1. Saving Data 

Data is saved from Graph windows, using Save Data File… ( ) on the File 
menu.  The following dialog is launched: 

 
Except for the options on the bottom, this is a standard Windows save dialog, 

and operates identically.  The options along the bottom allow you to choose whether 
to save raw, normal, or transposed data. 

"Save raw" is always checked for live data, and may not be unchecked.  Every 
single byte that was received from the instrument is saved into the raw data file.  
Such a file can be read back into RadSoft, to process the data differently at a later 
data.  The selected file name will be appended with the extension ".raw". 

"Save Normal" should be selected if you want to save calibrated data in normal 
format -- that is, with one row per data sample.  The selected file name will be 
appended with the extension ".dat".  If the instrument has several semi-independent 
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channels that are normally saved in separate files, then a letter corresponding to the 
channel will be added to the file name, before the ".dat" extension.  If live data is 
saved, and more data is collected, the additional data will be appended to the 
normal data file. 

"Save Transposed" should be selected if you want to save calibrated data in 
rotated format -- that is, with one column per data sample.  The selected file name 
will be appended with the extension ".dtt".  If the instrument has several semi-
independent channels that are normally saved in separate files, then a letter 
corresponding to the channel will be added to the file name, before the ".dtt" 
extension. If live data is saved, and more data is collected, the additional data will 
NOT be appended to the transposed file. 

If "Save Transposed" is selected, a few other options are available.  The column 
delimiter can be changed from the default comma to a space or tab.  Also, the 
maximum number of columns to output can be selected.  If the number of data 
columns (plus the header column) exceeds the specified number, then a new set of 
columns of data (with a new header column) follows later in the output.  This is 
useful if the data is to be imported into a program with limited columns, such as 
Excel, which can handle only 256 columns. 

8.2. Deleting All Data 
There are a few ways to remove data from RadSoft.  One way is to simply close 

all the graphs that contain the data to be deleted.  Another way, which only affects 
live data, is to use the Clear All Data… option on the Edit menu of graph windows 
(or  on the toolbar). 

Please note that if live data is being captured from an instrument, deleting 
displayed data will not remove data from the ".raw" data archive from the device. 

8.3. Selecting Data 
Using the slider, select the first data set to be kept.  Then press the shift key.  

While keeping the shift key down, drag the slider with the mouse over the range to 
be selected.  With the Delete and Crop commands, the selected data can either be 
deleted, or all the data outside the selected range can be deleted 

8.4. Deleting Data 
If the slider appears along the bottom of the graph, and the slider corresponds 

to data samples, the Delete Selected Data… option will appear enabled on the Edit 
menu (or  on the toolbar). If no data sets are selected with the slider, this deletes 
the current data set.  If a range of data has been selected, this deletes the selected 
range.  The delete key also works for deleting data. 

Please note that if live data is being captured from an instrument, deleting 
displayed data will not remove data from the ".raw" data archive from the device. 
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8.5. Cropping Data 
The data can also be cropped, by using the slider along the bottom of most 

graphs.  Selecting Crop Data to Selected Range… on the Edit menu of graph 
windows (or  on the toolbar) leaves the selected data range intact, but removes 
data outside the range.  This works whether the slider corresponds to data samples, 
or a range of other values (such as wavelengths). 

Please note that if live data is being captured from an instrument, cropping 
displayed data will not remove data from the ".raw" data archive from the device. 

8.6. Acquisition Limits 
Most devices will have a configurable "Acquisition Limit", which limits the 

number of samples stored during live data collection.  If the limit is left at zero, then 
it has no effect, and all live data will be stored in memory until memory fills.   

However, if a positive number is specified for the acquisition limit, then only 
that many samples will be stored in memory, and memory will not be likely to fill 
up.  When the limit is hit, samples will begin dropping off the live data graph (but 
will still be stored live to disk).  If this occurs, then the Crop and Delete commands 
in the Graph window become disabled.  Also, if Crop or Delete was previously used 
on a data set, and the data set's acquisition limit is subsequently reached, then the 
changes made by those commands will be discarded. 
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9. TERMINAL WINDOWS 
Each device has a corresponding terminal window that allows communicating 

directly to a connected instrument, and viewing, in raw form, the same data that are 
displayed graphically in the main data window.  It contains the same Instrument 
menu, status display, and instrument-control buttons as RadSoft Desktop and Graph 
windows.  These controls produce the same results whether you use them in the 
terminal window or in the other windows.  

 
There are a few extra editing controls in the terminal window that allow you to 

cut, copy, paste, and delete text to and form the window.  Pasted text is sent to the 
connected instrument. 
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10. RADSOFT DATA WINDOW 
Selecting Show Data from the View menu causes the RadSoft Data widow to 

appear.  This is a read-only window, designed to allow the browsing and copying of 
data from RadSoft directly into spreadsheets. 

If you open RadSoft Data widow from the RadSoft Desktop, then it will 
show the first data set that was collected.  Opening the RadSoft Data widow from a 
Terminal window will bring up the first live dataset from the device associated with 
the window.  Likewise, opening the RadSoft Data widow from a Graph window 
will bring up the first dataset in the graph.   

To see a different data set, click on the arrow in the box labeled "Data to 
Display".  The table will fill with data from the selected data set.  The data that 
appears in the RadSoft Data widow may be considerably more verbose than the 
data that appears in normal output or is available to graph.  This additional data 
may be necessary for debugging instrument behavior, or for understanding 
intermediate calibration steps. 

 
 To copy from the RadSoft Data widow, select the desired range with the 
mouse, holding down the shift key if you need to extend the selection beyond the 
visible data and use the scroll bars.  Right -clicking brings up a menu with cell 
selection and copy options.  The two cell selections allow you to either select all the 
cells (Ctrl-A), or select all the cells to the right and below the currently selected cell.  
The two copy selections allow you to either copy the selected data (Ctrl-C) or copy 
the selected data plus the data labels that appear to the left and above the data (Ctrl-
Insert). 
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11. SCRIPTS AND THE SCRIPT EDITOR 

11.1. Scripts 
Some devices such as the HydroRad have a DOS-like file system and can run 

script files containing a number of direct commands.  These script files reside on the 
flash disk of the device, and typically have a file name.  For example, on the 
HydroRad, files ending with the extension ".cmd" are considered to be script files, 
and can be run by typing the name of the file. 

An example script (shown in the script editor) follows below: 

 
 If the device support scripts, then there will be a set of script-specific 
commands on the Device-specific menu. These commands include: 

� Scripts Æ New Script: This creates a new script in the script editor 

� Scripts Æ Open Script This opens a script residing on the PC in the script 
editor.  

� Scripts Æ Run Script This will prompt you for the name of a script on the 
instrument to run on the instrument.  

� Scripts Æ Stop Script This will stop a script running on an instrument. 

The Device Explorer can also be used to edit and launch scripts. If the device 
is script enabled, the Device Explorer's File Menu will have a New Script item on it 
that launches the script editor with a new, blank script.   

Also, if a script file is selected in the Device Explorer, then right -clicking on 
the script brings up the options to Edit Script, which opens the selected script in the 
script editor, and Run Script, which runs the script on the device.  
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11.2. Script Editor 
The script editor is typically tailored for the target device, with syntax 

coloring and aids for generating proper syntax.  The File Menu has most of the 
typical commands of a text editor, plus the option to save to the device.   

Direct device-specific commands appear in the Insert Command menu.  
Clicking on an item from the menu launches the Command dialog that displays the 
command name, and includes an edit box of each filed of the command.  Help 
information is also displayed to assist the user with filling in the command: 

 
Pressing "Insert" inserts the correctly parsed command into the script. 

If you are unsure of the syntax for a command, type in the command, and 
right-click over it.  The syntax appears in a box over the command.  Clicking on the 
box actually inserts the syntax in place of the command that you just typed. 

The Script menu has two options: Save and Run Script ( ), which saves 
the script to the device and runs the script in one operation, and Stop Script ( ), 
which stops any running scripts on the device. 
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12. MENU REFERENCE 

12.1. Common File Menu Functions 
File: New Device (Appears only on the RadSoft Desktop) -- Opens connect 

dialog (see section 5.1.1) to add a new live device. If there are no devices on the 
RadDesktop, pressing the connect button , or Connect on the Instrument menu 
will also create a new device 

File: New Graph: (Not available from graph windows) If called from the 
RadSoft Desktop, if one or more device(s) are connected and selected, the graph 
will appear connected to those device(s), and will plot the data interactively from 
those device(s).  If no devices are selected when New Graph is selected, then the 
graph will be created blank, and data will need to be added to the graph through 
graph setup (see section 7.2).  If New Graph is called from a Terminal window, then 
the graph will appear connected to the device associated with the terminal, and will 
plot the data interactively from that device. 

Since default graphs automatically pop up whenever data is loaded from files 
or from instruments, New Graph is normally only used to create an alternate view 
into the data (i.e., plotting along a different axis), to combine the data from several 
default plots, or to display data from plots that have been deleted. 

File: New Live Data File: If called from the RadSoft Desktop, applies to 
currently selected devices.  If called from a Terminal window or a live Graph 
window, applies to the window's associated device(s).  If there is currently saved 
data, you will be prompted to save or discard it.  Then new .raw and .dat files will be 
created to acquire any new incoming data. 

File: Open File…: (in graph windows, this is called Open PC Files in New 
Graph) This opens a file stored on the PC. A file selector that allows you to select 
multiple files will appear.  You can click on "wildcard" match last digit of filename" 
to capture a set of similar files that differ only by the last character of their base file 
name (HydroRad files, for example). New graphs, with the newly loaded data from 
each file will be created. 

File: Open PC Files in this Graph…: (Appears only in graph windows) This 
opens a file stored on the PC.  This is identical to the Open File… command above, 
except that the opened files will appear in the current graph. 

 File: Connect to Instrument: Launches an interactive Connect dialog for 
the selected device(s) that are not currently connected. If there are no devices on the 
RadSoft Desktop, a new one will be created.  See section 5.1 for details about 
connecting.  
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 File: Reconnect to Instrument: If the selected device(s) were previously 
connected, and then disconnected (manually or by quitting the program), or if the 
device was created to be "Opened Later", this button quickly re-connects the device. 

 File: Disconnect from Instrument: This closes the serial port(s) of the 
currently selected instrument(s). 

 Acquire One Sample:  This command instructs the device to collect one 
sample, using the settings configured in the Item Setup window, and display the 
data in a graph. 

 Acquire Continuous Samples: This command instructs the device to 
collect continuous or evenly spaced samples, using the settings configured in the 
Item Setup window, displaying the live data in a graph. 

Log One Sample:  If the device can log to its own flash memory, this 
command instructs the device to collect and internally store one sample, using the 
settings configured in a dialog available through the device-specific menu. 

Log Continuous Samples:  If the device can log to its own flash memory, this 
command instructs the device to collect continuous or evenly spaced samples, using 
the settings configured in a dialog available through the device-specific menu. 

 Stop Sampling: This command stops continuous acquisition and/or 
logging. 

 File: Open Device Explorer: If selected device (RadSoft Desktop), or 
associated device (Graphs and Terminals) is a data logger, this launches an explorer-
like interface for downloading data. 

 File: Item Setup… (On the RadSoft Desktop only), if selected items are 
devices, the device-specific setup dialog appears to allow the device's data 
acquisition parameters to be changed.  If selected items are graphs, then the graph 
setup dialog is invoked (See section 7.2).  

 Acquisition Setup:  (Terminal and Graph windows only) The device-
specific setup dialog appears to allow the device's data acquisition parameters to be 
changed.  

 File: Calibration Files…: Allows you to edit which calibration file is used 
with which instrument. The PC location of calibration files is stored permanently, 
but can be changed through this interface.  Please note that when calibration files are 
downloaded from instruments, those files are stored in a RadSoft-created directory, 
and the calibration file association for the device is set to the newly downloaded file. 

12.2. RadSoft Desktop Edit Menu Functions 
Edit: Delete Item.  Appears if a device icon or graph icon is selected.  Deleting 

a device closes its port, closes its terminal widow, and deletes the device icon from 
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the desktop.  Deleting a graph icon closes its graph window and deletes the graph 
icon from the desktop.   

Edit: Select all Graphs: Selects all live graph icons. 

Edit: Select all Devices: Selects all device icons. 

12.3. RadSoft Desktop View Menu 

 View: Show Data: From the RadDesktop, this launches the data viewer in 
a mode which allows for the previewing of all data collected by RadSoft.  See section 
10 for a discussion of the data viewer. 

 View: Large Icons: Sets device and graph icons (see section 0) to use 64x64 
pixel large icons. 

 View Small Icons:  Sets device and graph icons (see section 0) to use 32x32 
pixel small icons. 

12.4. Common Window Menu 
Window: Cascade:  cascades all open windows 

Window: <Window Name>: this appears for each open window other than 
the current window.  Selecting a window from the list opens the window and brings 
it to the foreground. 
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13. CALIBRATION FILES 
In general, data are received from instruments in raw form, and must be 

converted to calibrated units. The coefficients required for this conversion are 
unique to each instrument, and may be revised from time to time when the 
instrument is recalibrated. RadSoft requires an appropriate calibration to be loaded 
before it can plot or store calibrated data from an instrument or raw data file.  

13.1. LOADING CALIBRATIONS  
Calibrations can be loaded either directly from a connected instrument, or from 

a file on the host computer. To load an instrument's calibration, check the "Load 
Calibration From Instrument" option while connecting to the instrument (see section 
0). Or, if the instrument is already connected, and you wish to download its 
calibration, select Load Calibration From Instrument from the Device-Specific 
Menu. 

To specify which calibration file to use for a currently connected instrument, 
use Load Calibration From PC from the Device-Specific Menu.  If the device is not 
connected, and you are processing stored data, the instrument calibration can still be 
changed by choosing Calibration Files…from the File menu, which launches the 
Change Calibration Associations window.  

 
If you select a new calibration file while an instrument is connected, or while a 

raw data file is open, RadSoft will only apply the calibration to data that is loaded 
after the change of calibration file. It will also warn you if the serial number of the 
instrument does not match that contained in the calibration file, but it will offer you 
the option of loading it even if the serial numbers do not match.  

Once a calibration file is loaded, it remains in effect until a different one is 
loaded. When you exit RadSoft, it stores the name of the current calibration file, 
along with the serial number and type of the instrument, for recall later. 
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14. DATA FILES  
For information about retrieving internally logged data from an instrument, 

see section 5.4.  

Data may be stored in raw form (in the form they are transmitted from an 
instrument), or in calibrated form, or both. RadSoft forces you to save your raw data 
files, for two main reasons. First, under some circumstances you may wish to apply a 
revised calibration to existing data. Second, raw files contain some housekeeping 
information that can be useful for troubleshooting in the event of a problem. 
Therefore when collecting data from an instrument, RadSoft always saves raw data, 
and gives you the choice of whether to save calibrated data simultaneously.  

RadSoft stores data directly to disk whenever a data file is open, even if it is a 
new, untitled file. Therefore the size of the files you collect is limited by your disk 
space, rather than your RAM, and you are less likely to lose data in the event of a 
computer crash.  

14.1. RAW DATA  
Raw data files contain a literal record of every byte received from an 

instrument during the time the file is open. Depending on the instrument type and 
its configuration this may consist of hexadecimal numbers, decimal numbers, text 
messages, binary data, or a mixture thereof. RadSoft adds a header at the beginning 
of the file with some information about its origin and history, but applies no 
formatting whatsoever to the main data. RadSoft normally names raw data files with 
the extension ".RAW".  

14.2. CALIBRATED DATA  
RadSoft normally names calibrated data files with the extension ".DAT".  

Calibrated data files start with a header identifying the origin and type of the 
data, followed by lines of comma-separated values. Below is a sample from a 
HydroRad data file.  

 
[Header] 
RadSoft Version=0.52 
Device Type=HydroRad-2 
File Creation Date=7/3/2003 4:00:51 PM 
Data Source=hr990501 
Data Source Date=7/3/2003 4:00:46 PM 
Serial=hr990501 
Channel=B 
Filter Type=Gaussian 
Filter Width=2.0 
Filter Width Units=nm 
Calibration File=C:\Calibration\hr990501.csx 
Channel Name=GuHigh 
Data Type=Scalar Irradiance 
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Units=W/m^2/nm 
Depth Offset=1432 
Depth Coefficient=0.00104355 
Time Format=1899 
Process=5 
Wavelengths=201 
[ColumnHeadings] 
Time,Temperature,Voltage,Depth,#Averaged,Do,Dt,IntTime,350.0,352.5, etc… 
[Data] 
37805.667118,25.19,13.39,-0.01,1,962.5,1132.0,1053,0.0390,0.0412,etc 
37805.667188,25.22,13.38,-0.01,1,979.0,1153.5,1053,0.0395,0.0419,etc… 

Transposed data has the same header format as regular data, but begins with 
the line "[Transposed Data]" instead of "[ColumnHeadings]". The data that would 
have appeared in the "[ColumnHeadings]" appears as the first column in the 
transposed data output.  Also, transposed data files have the extension ".DTT" 
instead of the standard ".DAT" for regular data files. 

  


